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Networking 
Networking technologies allow drives attached to systems across networks to be used as 
destination devices in DiscJuggler Professional Edition and DiscJuggler.NET. This chapter 
will follow through the process of using and configuring a server, along with a reference to 
each important section of the Padus Network Console: 
  

?? Creating a Server  
?? Using a Server  
?? Menus 

  

Features discussed in this section relating to network writing are only available 
in DiscJuggler Professional Edition and DiscJuggler.NET. See "Feature 
Limitations" for more information. 
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Creating a Server 
Creating a server using the networking technologies in DiscJuggler Professional Edition and 
DiscJuggler.NET is very straight-forward. Not all configuration details will be available in all 
licenses, so please keep that in mind while reading the following sections: 
  

?? Starting a Server  
?? Configuring a Server 
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Starting a Server 
 
To start a server, you must load the Padus Remote Console. This can be done in DiscJuggler 
by clicking on the Network Console icon ( ) in DiscJuggler or by clicking on the Network 
Console shortcut in the Start menu (default location: Start -> Programs -> Padus DiscJuggler 
-> Network Console). 
  

 
  
After the Padus Remote Console has started, you need to start the Network Server service. 
This can be done by going to File -> Share network writer(s)... (shown above). This will open 
the primary configuration window for the Network Server service. 
 

 
The parameters listed here will determine how the service will start, and these settings cannot 
be changed while the service is running: 
  

Web port 
  
DiscJuggler.NET contains a simple web interface for administrative functions and 
monitoring. The port that the web runs on can be changed to not interfere with other 
web services that could be running on the host system. 
  
Service port 
  
All licenses have the ability to change the default service port that the Network Server 
service runs on. This is useful if another service needs to use this port on the host 
system, as unlikely as that might be. 
  
Web root 
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 The location where the web interface binaries are contained. The default location is 
located in the web directory of the root DiscJuggler program files directory. 
  
Share only SCSI drives 
 
This option can be selected if the host system only needs to make SCSI drives 
available. The SCSI bus is the first bus scanned when our architecture scans for drives, 
so you can speed up the start time by selecting this option. 
  
Server startup mode 
  

?? Start automatically at every system startup 
 
This option is beneficial if the host system has long-term plans as a server. 
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?? Start only in this session 
 
This option will make sure the service does not start when Windows loads. 

  
Pressing the Start button on this window will begin the service. For additional configuration 
options, please read the "Configuring a Server" section. 
  

Features discussed in this section might not be available in the DiscJuggler 
license you purchased. The advanced networking technologies are available in 
DiscJuggler.NET. See "Feature Limitations" for more information. 
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Configuring a Server 
Once the Network Server service has been started, there are multiple configuration options in 
DiscJuggler.NET: 
  

?? Configure Server  
?? Print Options  
?? Disk Options  
?? User Management  
?? Job Management  
?? Writer Management 

 

  

Features discussed in this section might not be available in the DiscJuggler license you 
purchased. The advanced networking technologies are available in DiscJuggler.NET. See 
"Feature Limitations" for more information. 

 
  

 
  
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Configure Server 
 
To configure the server that has is now running (please see "Starting a Server" if the Network 
Server service is not running), you will have to log in to the server with Operator privileges. If 
the service has been started for the first time, the username and password will be blank. 
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Description 
  
Optional label for the name of the host system. This will be displayed throughout DiscJuggler 
and the Padus Network Console. 
 
Location 
 
Optional label for the location of the host system. This will also be displayed in DiscJuggler 
and the Padus Network Console. 
  
Accept incoming jobs 
 
Select this option if the server should queue jobs sent in from clients. Disable this feature if 
server configuration changes need to be made while clients should not be able to send in new 
jobs. 
 
Process jobs in queue 
 
Select this option if the server should being writing queued jobs sent in from clients. Disable 
this feature if the server needs to accept incoming jobs, but not process them immediately. 
This can be put to good use if the server is temporarily out of media. 
  
Max jobs in queue 
  
Maximum jobs allowed to be queued at one time. The only physical limitation to this value is 
the amount of available storage space that can be used by the Network Server service. 
  
Max connections 
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Maximum number of jobs that can be transferred by clients at one time. 
  
Max fails per job 
  
Maximum attempts to write a job before the job is deleted. 
  
Max fails per writer 
 
Maximum attempts to write a job in one writer before that writer is deactivated. 
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Write speed for Audio CDs 
  
Maximum CD write speed clients can select for CD-DA discs. 
  
Write speed for Data CDs 
  
Maximum write speed clients can select for writing CD-ROM or CD-XA discs. 
  
Write speed for DVDs 
  
Maximum write speed clients can select for writing DVD discs. 
  
Enable test mode (pseudo-write) 
  
Write process uses the read power level for the laser of the writing drives, which can be used 
to test the full process without writing to the blank disc. 
  
Erase re-writable media if not blank 
  
If re-writable media is not blank, Network Server service will erase disc before writing job. 
  

Quick mode 
  
Re-writable disc erasure only erases table of contents, which speeds up the erase 
process. 
  

Use buffer under-run prevention technology (when available) 
  
Many drives feature buffer under-run prevention technology, to limit the possibility of the data 
buffer losing data that it must have for the writing process to succeed. The technology can 
pause the write process until the buffer has the amount of data necessary to complete the 
process, and begin again where the process was paused. This procedure, while saving the 
write process, will slow the process down. Common names for the technology include 
"BURN-Proof" or "JustLink" to name a few. 
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Timeout  (min) 
  
After this many minutes of inactivity in the web interface, the current session will expire. 
  
Enable user security 
  
Only users with proper security clearance can log in to the server. 
 

Features discussed in this section might not be available in the DiscJuggler 
license you purchased. The advanced networking technologies are available in 
DiscJuggler.NET. See "Feature Limitations" for more information. 

 
  

 
  
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 231

Print Options 
 
The networking technologies available in DiscJuggler Professional Edition and 
DiscJuggler.NET can be put to good use with the addition of a disc label printer. The following 
options can be found by pressing the "Print options" button of the "Configure server" window, 
when a printer is attached to the host system. 

  
 

 
Enable disc label printer support 
 
This will enable use of a support disc label printer by clients using the Padus Remote 
Console, connected to the service running on the host system. 
  
Printer 
  
Choose the supported disc label printer for use with the Padus Remote Console. 
  
Print default label 
  
A default label file can be selected to be printed on each disc sent through the Network 
Server service. 
  
Background image 
  
Any image file in the DiscJuggler program files root directory can be set as the disc label 
background on each disc sent through the Network Server service. 
  
Print job number 
  
Select this option to print job number on each disc sent through the Network Server service. 
  
Print username/IP address 
  
Select this option to print the user who submitted the job and the client system they were 
using on each disc sent through the Network Server service. 
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Disk Options 
  
Multiple hard disks can be used for queuing jobs for the writing process. This feature is 
important when a high volume of jobs are being sent to the server and there are multiple 
writing drives to handle the writing process of multiple tasks. 
  

 
  
Cache disk 
  
This hard disk is used for caching incoming jobs before all job data has been transferred to 
the host system. 
  
Disk array 
  
Multiple hard disks can be added to balance the load of data transferring between the source 
hard disks and destination writing drives. 
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Please visit the "Multi-tasking to Multiple Drives" section of the "Advanced Concepts" chapter 
for additional information on the requirements for multi-task writing. 
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User Management 
 
DiscJuggler.NET features increased security through multiple user management options. 
Client access to the Network Server service can be limited by IP addresses or by user 
accounts. Users can be limited by the drives, amount of discs, and types of discs they can 
use. User class templates are provided for fast configuration of a user's privileges. 
  

 
  
User table 
  
This section is used to display the users currently configured to use the Network Server 
service on the host system and provide a method to add and remove users. To remove a 
user, right-click on a username and select the "Remove user" option. 
  

?? Username 
 
Login name for the user to be added to the user table. 
 

?? Password 
 
Password for the user name to be added to the user table. 
 

?? Class 
 
Privilege template for the user to be added to the user table. The Operator class allows 
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for complete configuration control of the host system. The Superuser class has all of 
the privileges to the system as the Operator class does, but cannot change the 
configuration. The User class can be completely limited depending on the level that an 
Operator chooses, but does not have any ability to change the configuration. 

  
Client table 
  
This section is used to display the client systems currently allowed or denied from using the 
Network Server service on the host system and provide a method to block client systems 
from having access to the host system. To remove a block, right-click on a client and select 
the "Remove client" option. 
  

?? IP address 
 
Address of the client system to be added to the client table. 
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?? Class 
 
Class setting for the client system to be added to the client table. 
 

?? Deny 
 
Access setting for the client system to be added to the client table. Choosing "Yes" will 
prevent the client system from accessing the host system's Network Server service, 
while "No" will allow the client system to access the host system's Network Server 
service. 

  
Operator/Superuser/User 
  

?? Max copies per job 
 
Maximum number of copies per job that can be selected by this class template. 
 

?? Max writers in use 
 
Maximum number of writing drives that can be used by this class template. 
 

?? Max jobs in queue 
 
Maximum number of queued jobs that can be used by this class template. 
   

?? Accept CD jobs 
 
Class template can send jobs of the Compact Disc variety. 
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?? Accept DVD jobs 
 
Class template can send jobs of the Digital Versatile Disc variety. 
 

?? Accept write speed 
 
Class template can select the writing speed of a job. 

  

Features discussed in this section might not be available in the DiscJuggler 
license you purchased. The advanced networking technologies are available in 
DiscJuggler.NET. See "Feature Limitations" for more information. 
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Job Management 
 
When a job is in the process of being sent to the Network Server service, the Operator class 
can delete jobs, increase job priority, or decrease job priority. 
  

 
  
To manage the jobs, either control the functions in the "Action" menu or right-click on the job 
to use the functions. The ability to manage jobs can depend on the user class assigned to the 
current login. 
  

?? Delete job 
 
Job is removed from the queue or terminated if it is in the writing process. 
  

?? Increase priority 
 
Job is moved to a higher position in the order of when the queued jobs will be written. 
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?? Decrease priority 
 
Job is moved to a lower position in the order of when the queued jobs will be written. 

  
Features discussed in this section might not be available in the DiscJuggler 
license you purchased. The advanced networking technologies are available in 
DiscJuggler.NET. See "Feature Limitations" for more information. 
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Writer Management 
 
Any writing drive associated with the Network Server service can be managed by the 
Operator class. 
  

 
  
To manage the writers, either control the functions in the "Action" menu or right-click on the 
job to use the functions. 
  

?? Enable writer 
 
Writing drive is currently active for use by any client to transfer jobs to use the drive. 
   

?? Disable writer 
 
Writing drive is currently inactive for use by any client through the Network Server 
service. 
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?? Properties 
 

 
 
Displays the writing drive information. This can be viewed by any user class. 
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Using a Server 
 
Sending jobs to a host system running the Network Server service can be accomplished 
through DiscJuggler Network Edition, DiscJuggler Professional Edition, or DiscJuggler.NET 
because each of these licenses include the ability to select shared network drive(s) as the 
Destination device in each task and come bundled with the Padus Network Console. 
  
To use a server, you must load the Padus Remote Console. This can be done in DiscJuggler 
by clicking on the Network Console icon ( ) in DiscJuggler or by clicking on the Network 
Console shortcut in the Start menu (default location: Start -> Programs -> Padus DiscJuggler 
-> Network Console). 
  

 
Explanations on the ways to use a Network Server are covered in the following sections: 
  

?? Login to Server  
?? Send Jobs with DiscJuggler  
?? Send Jobs with Console 
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Login to Server 
 
After loading the Padus Network Console, you must login to a server to utilize all of the 
functions. 
  

 
  
Each server is listed with the server name, location, service version, host IP address, web 
port, and service port. To obtain a list of available servers, you must click the "Update list" 
button. 
  
Login 
 
Connect to selected server. 
  
Add 
  
Manually add a server to the server list. This is useful is the server is not available through 
the local network, but a global network. Use the TCP/IP address of the desired host system to 
connect. 
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Update list 
  
The client service will use UDP port 3700 to scan for host systems running the Network 
Server service on the local network. 
  
Once the server has been selected, you are presented with a prompt for the username and 
password information before being able to use the server. Username and password 
authentication will only be required on DiscJuggler.NET servers that require this level of 
security. 
  

 
  
Username 
  
This is the name of the account created in DiscJuggler.NET, which has access to the Network 
Server service. 
  
Password 
 
This is the password, or login security of the above account. 
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Force user identification 
 
Enables password authentication to Network Server service. 
  
Automatic login next time 
  
Saves username and password for automatic login next time the Padus Network Console is 
used. 
 

Features discussed in this section might not be available in the DiscJuggler 
license you purchased. The advanced networking technologies are available in 
DiscJuggler.NET. See "Feature Limitations" for more information. 
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Send Jobs with Console 
 
Jobs can be sent in the form of disc image files to the Network Server service with the Padus 
Network Console. The console supports drag-and-drop capabilities for supported file types. 
  

 
  
Once a disc image has been dropped onto the console (or File -> Send image file), you will 
be prompted for other options. 
  
CD/DVD label 
  
The disc label file to be printed by an available disc printer. This file can be a .BMP (Windows 
bitmap), .JPG, or .PRN (raw printer data) file. 
  
Copies 
  
The number of disc copies desired for this job. A messaged will be displayed if your account 
privileges do not allow for certain values. 
  
Speed 
  
The write speed for this job. A messaged will be displayed if your account privileges do not 
allow for certain values. 
  
Support 
  
Disc type for this job. A messaged will be displayed if your account privileges do not allow for 
certain values. 
  
Text overlay 
  
The text label to be printed by an available disc printer. 
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Send Jobs with DiscJuggler 
 
Jobs can be sent through the DiscJuggler front-end and the various tasks it contains. To 
make sure DiscJuggler has proper authentication on servers that require a username and 
password, you must first login to the server, but make sure you use the "Show next time" 
feature, as indicated below. 
  

 
  
Once that has been done, you can use DiscJuggler to use the server as an available 
destination device. 
  

 
  
If the destination server has specific privileges by user class, all options in the task might not 
be available. 
  

Features discussed in this section might not be available in the DiscJuggler 
license you purchased. The advanced networking technologies are available in 
DiscJuggler.NET. See "Feature Limitations" for more information. 
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Menus 
The following is the complete list of menus and commands available in the Padus Remote 
Console. Where applicable, each command is listed with its correspondent shortcut and icon: 
  

?? File  
?? View  
?? Action  
?? Help 
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File 
 
Use the File menu to login, send image files, share a network writer, view a detailed log, quit 
the program, or perform additional functions: 
  
Login 
 
Displays "Server list" window for viewing or adding servers. 
Shortcut: Ctrl + L 
 
Always on top 
  
Forces Padus Remote Console window to always float above all other windows. 
  
Send image file 
  
Displays "Send image file" window for sending disc images to current server. 
Shortcut: Ctrl + I 
  
Share network writer(s) 
  
Displays "Share network writer(s)" window for configuration before starting network service on 
local system. 
  
Stop shared network writer(s) 
  
Stops network service on local system. 
  
Show log 
  
Displays log for network service on local system. 
  
Configure server 
 
Displays configuration options for current server. 
  
Close window 
  
Minimizes window to system tray. 
Shortcut: F10 
  
Exit 
  
Exits the program. 
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View 
 
Use the View menu load windows listing current jobs on the server, writers on the server, or 
the server log: 
  
Jobs 
  
Displays current jobs on the server and functions to control these jobs. 
Shortcut: F1 
  
Writers 
  
Displays writers on the server and functions to control these writers. 
Shortcut: F2 
  
Log Messages 
  
Displays log messages from the server. 
Shortcut: F3 
  
Refresh 
  
Updates the current window information. 
Shortcut: F5 
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Action 
 
Use the Action menu to perform actions on jobs and writers associated with the server: 
  
Delete job 
  
Deletes the selected job from queue. 
  
Increase priority 
  
Increases the priority of the selected job. 
  
Decrease priority 
  
Decreases the priority of the selected job. 
  
Enable writer 
  
Changes status of writing drive to available over the network server. 
  
Disable writer 
  
Changes status of writing drive to unavailable over the network server. 
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Help 
 
Use the Help menu to view the information about the Padus Remote Console: 
  
About 
  
Displays the program information, version number and copyright. 
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